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Merk: I hele dette dokumentet henviser WatchPAT til alle de fire enhetene (WP200, WP200U, WatchPAT™ 300 og WatchPAT™ ONE), med mindre annet er angitt.

Den utvidede og illustrerte veiledningen finnes på nettstedet til Itamar-Medical ( https://www.itamar-medical.com/support/downloads/  )

[bookmark: _Toc500760470][bookmark: _Toc75938721][bookmark: _Toc396387020][bookmark: _Toc203489306][bookmark: _Toc502848050][bookmark: _Toc502848048][bookmark: _Toc513360263][bookmark: _Toc534108048][bookmark: _Toc5874853][bookmark: _Toc9050222][bookmark: _Toc125380222]Tiltenkt bruk / indikasjoner for bruk av Watch-PAT200
Watch-PAT200 («WP200») er et ikke-invasivt apparat til hjemmepleie for bruk på pasienter som mistenkes å ha søvnrelaterte pusteforstyrrelser. WP200-enheten brukes som et diagnostisk hjelpemiddel for påvisning av søvnrelaterte pusteforstyrrelser og søvnstadier (Rapid Eye Movement (REM) søvn, lett søvn og dyp søvn). Enheten genererer en perifer arteriell tonometri («PAT»), pusteforstyrrelsesindeks («PRDI»), apné-hypopnéindeks («PAHI») og identifikasjon av PAT-søvnstadier («PSTAGES») og valgfrie diskrete tilstander for snorkenivå og kroppsposisjon fra en ekstern integrert snorke- og kroppsposisjonssensor (SBP). Enhetens «PSTAGES» og SBP leverer tilleggsinformasjon til PRDI/PAHI. Enhetens «PSTAGES» og SBP er ikke ment for bruk som eneste eller primært grunnlag for diagnostisering av søvnrelaterte pusteforstyrrelser, behandlingsforeskrivning eller for å beslutte om ytterligere diagnostisk vurdering er nødvendig.

WP200 er ikke indisert for barn under 17 år.
[bookmark: _Toc75938722][bookmark: _Toc125380223]Tiltenkt bruk / indikasjoner for bruk av Watch-PAT200U , WatchPAT™ 300 og WatchPAT™ ONE
Enhetene Watch-PAT200U (WP200U), WatchPAT™ 300og WatchPAT™ ONE er ikke-invasive apparater til hjemmepleie for bruk på pasienter som mistenkes å ha søvnrelaterte pusteforstyrrelser. WP200U, WatchPAT™ 300 og WatchPAT™ ONE er diagnostiske hjelpemidler for påvisning av søvnrelaterte pusteforstyrrelser, søvnstadier (REM-søvn) søvn, lett søvn, dyp søvn og våken), snorkenivå og kroppsposisjon. Enhetene genererer en perifer arteriell tonometri («PAT») respiratorisk forstyrrelsesindeks («PRDI»), apné-hypopnéindeks («PAHI»), sentral apné-hypopnéindeks («PAHIc»), identifikasjon av PAT-søvnstadier (PSTAGES) og valgfrie diskrete tilstander for snorkenivå og kroppsposisjon fra en ekstern integrert snorke- og kroppsposisjonssensor. Enhetens PSTAGES og snorkenivå og kroppsposisjon leverer tilleggsinformasjon til enhetens PRDI/PAHI/PAHIc. Enhetens PSTAGES og snorkenivå og kroppsosisjon er ikke ment for bruk som eneste eller primært grunnlag for diagnostisering av søvnrelaterte pusteforstyrrelser, behandlingsforeskrivning eller for å beslutte om ytterligere diagnostisk vurdering er nødvendig.

PAHIc er indisert for bruk på pasienter 17 år og eldre. Alle andre parametere er angitt for pasienter 12 år og eldre.

Merk: Presentasjon av pAHIc er underlagt godkjenning fra landets myndigheter
[bookmark: _Toc75938724][bookmark: _Toc396387021][bookmark: _Toc203489307][bookmark: _Toc125380224]ZzzPAT S/W - Definisjon 
ZzzPAT er en analyseprogramvarepakke som brukes sammen med WP-enhetene for å bidra til å diagnostisere søvnrelaterte pusteforstyrrelser, oppdage REM, lett søvn, dyp søvn og våkne stadier og måle snorkeintensitet og kroppsposisjonstilstander. ZzzPAT S/W viser signalene som registreres av WP-enhetene, identifiserer automatisk pusteforstyrrende hendelser, søvnstadier og snorke- og kroppsposisjonsdata og genererer en omfattende rapport til bruk av lege.
[bookmark: _Toc75938725][bookmark: _Toc396387022][bookmark: _Toc203489308][bookmark: _Toc125380225]Oversikt

ZzzPAT-algoritmene bruker de fire WP-kanalene: PAT, pulsfrekvens, aktigrafi og oksygenmetning (enten registrert i WP200 eller avledet fra WP200U/ WatchPAT™ 300/ WatchPAT™ ONE) til å påvise søvnrelaterte pusteforstyrrelser og søvnstadier (REM, lett søvn, dyp søvn og våken) . I WP200U, WatchPAT™ 300 og WatchPAT™ ONE tillater bruk av RESBPs pustebevegelseskanal, i tillegg til de andre WP-kanalene, ytterligere identifisering av sentral apné. 
zzzPAT bruker WPs snorke- og kroppsposisjonskanaler til å generere diskrete tilstander for snorkenivå og kroppsposisjon. Programvaren oppretter omfattende rapporter om studien, med statistikk og grafisk fremstilling av resultatene. Data for hele natten kan vises og de automatisk oppdagede hendelsene kan gjennomgås manuelt.

Merk: I hele dette dokumentet henviser snorke- og kroppsposisjonssensoren både til SBP-sensoren og RESBP-sensoren, med mindre annet er angitt. I WP200(U)/WP300 er bruk av snorke- og kroppsposisjonssensoren valgfritt og avhenger av hva legen foretrekker. Bruk av RESBP-sensor er underlagt godkjenning fra landets myndigheter.

Denne håndboken inneholder de nødvendige opplysningene for rutinemessig bruk av zzzPAT-programvaren.

Begrensninger
Sporingsdatatene og beregningene fra WP-systemene er ment til hjelp ved diagnostisering av søvnpusteforstyrrelser. De skal uttrykkelig ikke anses som et enkeltstående eller uomtvistelig grunnlag for klinisk diagnose.
ZzzPAT-programvaren skal bare kjøres på kompatible datamaskiner som oppfyller kravene som er angitt i dette dokumentet.
Riktig funksjon kan forstyrres ved kjøring av andre programmer, kommersielle eller tilpassede, samtidig med zzzPAT.
Ved konfigurasjon for delt database bør hvile-/dvalemodus deaktiveres.


[bookmark: _Toc75938726][bookmark: _Toc396387023][bookmark: _Toc125380226]Installasjon
[bookmark: _Toc75938727][bookmark: _Toc396387024][bookmark: _Toc534108050][bookmark: _Toc513360265][bookmark: _Toc125380227]Generell beskrivelse av zzzPAT-programvaren
zzzPAT er en varemerkebeskyttet PC-programvare som er spesielt utviklet for administrering og analysering av data registrert av WP-enheten. Programvaren viser og lagrer de registrerte signalene og tilveiebringer et sett med analytiske funksjoner for tolkningsformål.

I WP200 (U)/ WatchPAT™ 300 brukes en USB-kabel til avlesing av dataene som registreres av WP på det innebygde minnekortet. ZzzPAT S/W oppdager automatisk dataene på det interne minnekortet når WP kobles til PC-en med USB-kommunikasjonskabelen.
I WatchPAT™ ONE brukes en internettforbindelse til å lese dataene som er registrert av WatchPAT™ ONE. ZzzPAT S/W åpner automatisk en liste over alle registrerte pasienter hvis studier enda ikke er hentet fra webserveren.
Se avsnitt 0 for påkrevd PC-konfigurasjon.

zzzPAT kan brukes i to moduser:

Frittstående - for bruk på en enkelt PC med en lokal database.
Delt tilgang - for bruk i nettverksmiljøer der flere zzzPAT-stasjoner har tilgang til en enkelt, delt database. 
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	Merk

	
	Det anbefales på det sterkeste at innstillingene for zzzPAT-driftsmodus med delt tilgang koordineres med en Itamar Medical-representant. Ekstra opplæring kreves for riktig drift.
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	WatchPAT200U-enheten betjenes fra PC. Bruk av antivirusprogramvare anbefales for å beskytte systemet og filene dine, i tillegg til bruk av tilstrekkelig brukeradgangskontroll.



[bookmark: _Toc534108124][bookmark: _Ref30906401][bookmark: _Toc396387025][bookmark: _Toc513360266][bookmark: _Toc534108051]zzzPAT-enhetens driftsmåte bestemmes under installering, som ytterligere beskrevet i installasjonsavsnittet i den utvidede og illustrerte veiledningen
[bookmark: _Toc448932632][bookmark: _Toc448932636][bookmark: _Toc448932639][bookmark: _Toc448932640][bookmark: _Toc448932642][bookmark: _Toc396386972][bookmark: _Toc396387028][bookmark: _Toc396386973][bookmark: _Toc396387029][bookmark: _Toc448932647][bookmark: _Toc448932648][bookmark: _Toc448932649][bookmark: _Using_zzzPAT_Software][bookmark: _Toc502848056][bookmark: _Ref508259397][bookmark: _Ref508259407][bookmark: _Ref508536776][bookmark: _Ref508536782][bookmark: _Toc513360268]
[bookmark: _Ref530980953][bookmark: _Toc534108054]
[bookmark: _Toc75938728][bookmark: _Toc396387035][bookmark: _Ref29868162][bookmark: _Toc125380228]Sette opp zzzPAT-konfigurering
[bookmark: _Toc448932658][bookmark: _Toc448932657][bookmark: _Toc448932656][bookmark: _Toc448932655][bookmark: _Toc75938729][bookmark: _Toc396387037][bookmark: _Toc534108100][bookmark: _Toc513360303][bookmark: _Toc125380229]Oppsett>Kataloger
Viser zzzPAT-arbeidskatalogen, navnet på den tilkoblede databasen, filkatalogen (signalfildata) og USB-stasjonen. 

Velg «DB-innloggede brukere» for å vise hvem som er koblet til den delte databasen. 
Listen inneholder navnet på alle datamaskiner som deler den samme databasen og som har zzzPAT-programmet kjørende.
[bookmark: _Toc396387038][bookmark: _Toc534108101][bookmark: _Toc513360300][bookmark: _Toc502848061][bookmark: _Toc75938730][bookmark: _Toc125380230] Oppsett>Brukerinnstillinger 
Brukeren kan endre følgende oppsettparametre ved å åpne dialogboksen «Brukerinnstillinger» fra Oppsett>Brukerinnstillinger. Oppsettparametrene for «Brukerinnstillinger» er lagret i zzzPAT-databasen for hver bruker (enten i den lokale databasen i en frittstående installasjon eller en delt tilgangsdatabase i en Shared Access-installasjon).

	[image: clip_image002]
	Merk

	
	I delt tilgangsmodus, når en bruker logger på fra flere zzzPAT-stasjoner samtidig, kan det hende at endringer i noen av de brukerkonfigurerbare zzzPAT-innstillingene ikke lagres når zzzPAT-økten er avsluttet




[bookmark: _Toc534108102][bookmark: _Toc513360302]Når alle innstillinger er fullført, klikker du på OK for å lukke dialogboksen Innstillinger.

Se Utvidet og illustrert veiledning for detaljert beskrivelse
[bookmark: _Toc23069019][bookmark: _Toc23069018][bookmark: _Toc23069017][bookmark: _Toc23069016][bookmark: _Toc23069015][bookmark: _Toc23069014][bookmark: _Toc23069013][bookmark: _Toc23069012][bookmark: _Toc23069011][bookmark: _Toc23069010][bookmark: _Toc23069009][bookmark: _Toc23069008][bookmark: _Toc23069007][bookmark: _Toc23069006][bookmark: _Toc23069005][bookmark: _Toc23069004][bookmark: _Toc23069003][bookmark: _Toc23069002][bookmark: _Toc23069001][bookmark: _Toc23069000][bookmark: _Setup>User_Settings>Options][bookmark: _Toc23068999][bookmark: _Toc23068998][bookmark: _Toc23068997][bookmark: _Toc23068996][bookmark: _Toc23068995][bookmark: _Toc23068994][bookmark: _Toc23068993][bookmark: _Toc23068992][bookmark: _Toc23068991][bookmark: _Toc23068990][bookmark: _Toc23068989][bookmark: _Toc23068988][bookmark: _Toc23068987][bookmark: _Toc23068986][bookmark: _Toc23068985][bookmark: _Toc23068984][bookmark: _Toc23068983][bookmark: _Toc23068982][bookmark: _Toc23068981][bookmark: _Toc23068980][bookmark: _Toc23068979][bookmark: _Toc23068978][bookmark: _Toc23068977][bookmark: _Toc23068976][bookmark: _Toc23068975][bookmark: _Toc75938731][bookmark: _Toc396387039][bookmark: _Ref5871947][bookmark: _Toc534108104][bookmark: _Toc513360304][bookmark: _Toc125380231]Oppsett>Generelle innstillinger
Bare en bruker som har «Brukeradministrasjon»-tillatelsen kan endre følgende oppsettparametre ved å åpne dialogboksen «Generelle innstillinger» fra Oppsett>Generelle innstillinger. «Generelle innstillinger» er lagret i zzzPAT-databasen (enten i den lokale databasen i en frittstående installasjon eller en delt tilgangsdatabase i en Shared Access-installasjon).

Disse innstillingene er globale. Endrede innstillinger gjøres tilgjengelige for alle brukere.

[bookmark: _Toc396387102]Når alle innstillinger er fullført, klikker du på OK for å lukke dialogboksen Generelle innstillinger. 

Se Utvidet og illustrert veiledning for detaljert beskrivelse

[bookmark: _Toc23069086][bookmark: _Toc23069085][bookmark: _Toc23069084][bookmark: _Toc23069083][bookmark: _Toc23069082][bookmark: _Toc23069081][bookmark: _Toc23069080][bookmark: _Toc23069079][bookmark: _Toc23069078][bookmark: _Toc23069077][bookmark: _Toc23069076][bookmark: _Toc23069075][bookmark: _Toc23069074][bookmark: _Toc23069073][bookmark: _Toc23069072][bookmark: _Toc23069071][bookmark: _Toc23069070][bookmark: _Toc23069069][bookmark: _Toc23069068][bookmark: _Toc23069067][bookmark: _Toc23069066][bookmark: _Toc23069065][bookmark: _Toc23069064][bookmark: _Toc23069063][bookmark: _Toc23069062][bookmark: _Toc23069061][bookmark: _Toc23069060][bookmark: _Toc23069059][bookmark: _Toc23069058][bookmark: _Toc23069057][bookmark: _Setup>General_Settings>Analysis/Sta][bookmark: _Toc23069056][bookmark: _Toc23069055][bookmark: _Toc23069054][bookmark: _Toc23069053][bookmark: _Toc23069052][bookmark: _Toc23069051][bookmark: _Toc23069050][bookmark: _Toc23069049][bookmark: _Toc23069048][bookmark: _Toc23069047][bookmark: _Toc23069046][bookmark: _Toc23069045][bookmark: _Toc23069044][bookmark: _Toc23069043][bookmark: _Toc23069042][bookmark: _Toc23069041][bookmark: _Toc23069040][bookmark: _Toc23069039][bookmark: _Toc23069038][bookmark: _Toc23069037][bookmark: _Toc23069036][bookmark: _Toc23069035][bookmark: _Toc23069034][bookmark: _Toc23069033][bookmark: _Toc23069032][bookmark: _Toc23069031][bookmark: _Toc23069030][bookmark: _Toc23069029][bookmark: _Toc23069028][bookmark: _Toc23069027][bookmark: _Toc23069026][bookmark: _Toc23069025][bookmark: _Toc23069024][bookmark: _Toc23069023][bookmark: _Toc23069022][bookmark: _Toc23069021][bookmark: _Toc75938732][bookmark: _Toc396387040][bookmark: _Toc125380232]Bruk av zzzPAT
[bookmark: _Toc75938733][bookmark: _Ref449876863][bookmark: _Toc396387041][bookmark: _Toc125380233]Utarbeiding av en ny studie
Utarbeiding av pasientfilen er et obligatorisk trinn i utarbeiding av WP-enhetene i en søvnstudie. 

Starte zzzPAT
Start «Veiviser for zzzPAT-database» ved å klikke på zzzPAT-ikonet [image: ] på skrivebordet.
Hvis zzzPAT-ikonet [image: ] startes, åpnes påloggingsdialogen:

Angi brukernavn og passord. Når en modus for delt tilgang er installert, lar påloggingsskjermen brukeren velge hvilken database zzzPAT skal koble seg til. 
Dialogboksen for pålogging har to alternative påloggingstyper: 
· Aktiv katalog (nåværende domeneserver). 
· Brukere fra zzzPAT-databasen 

Velg eventuelt ønsket database for tilkobling.
Angi påloggingsnavn og passord, og klikk på OK for å fortsette.

[bookmark: _Ref244001441]Utarbeiding av en ny studie

Vinduet Ny studie åpnes med felt i henhold til standard enhetstype (WP200(U)/ WatchPAT™ 300/ WatchPAT™ ONE) i henhold til konfigurasjonen.

Klargjøring av en ny studie (WP200(U)/ WatchPAT™ 300)

Kontroller at enheten er koblet til PC-en med zzzPAT-programvaren gjennom USB-kabelen.
Klikk på Fil>Nye studiedetaljer i zzzPAT eller klikk på «Ny studie»-ikonet [image: ] i verktøylinjen.
Dialogboksen «Ny studie» vises.
Fyll ut obligatorisk pasient-ID i feltene Pasient. 
Angi eventuell tilleggsinformasjon, de øvrige feltene er valgfrie.
Velg «Pacemaker» hvis pasienten har en implanterbar pacemaker. ZzzPAT oppdager automatisk segmenter der PAT-puls ser ut til å være stimulert, dvs. svært lave pulsfrekvenservariasjoner (tilnærmet stabil) og utelate disse segmentene fra analysen.

	[image: clip_image002]
	Merk

	
	Enkelte typer pacemakere tillater ikke bruk av WatchPAT-enheten. Se avsnittet om eksklusjonskriterier i enhetens bruksanvisning for ytterligere detaljer.




Velg «Studer med inngrepssikker testing» hvis du vil bruke pasientidentifikasjonsarmbåndet. Ved å aktivere dette alternativet kan du bruke armbåndet for å bekrefte at den identifiserte pasienten faktisk er personen som sover med enheten (se Inngrepssikker testing i bruksanvisningen for WP).
Velg alternativet «Flere netter» for å kjøre opptil 3 netter med den samme WP-enheten
WatchPAT™ 300: Alternativet «Kjør enhetstest» vises bare så lenge en enhet er tilkoblet. Når dette alternativet er valgt, vil den tilkoblede enheten testes og resultatene vises i et eget vindu. Denne testen utfører den samme «Test enhet»-operasjonen fra en frittstående enhet (se Operatørstester i bruksanvisningen for WP).
WatchPAT™ 300: Alternativet «Kjør enhetstest ved lagring ...» vises bare så lenge en enhet er tilkoblet. Når dette alternativet er valgt, vil den tilkoblede enheten testes automatisk når brukeren velger «Lagre til WatchPAT», og resultatene vises i et eget vindu. Denne testen utfører den samme «Test enhet»-operasjonen fra en frittstående enhet.
For å registrere en studie for WatchPAT™ ONE-enheten bruker du knappen "Bytt til WP-ONE-enhet"
Klikk på Lagre til WatchPAT-knappen.
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	Enhetene som brukes for vekt og høyde i dialogboksen «Ny studie» er definert av PC-ens regionsinnstillinger.



Hvis WP inneholder data (enten en nattstudie som ikke har blitt lastet opp til zzzPAT-databasen eller nye pasientdata som er klargjort men ikke brukt i en studie), åpnes dialogboksen Data ikke innlastet
Når pasientopplysningene er lagret til WP, vises meldingen om at lagringen er utført

Klikk på Ja - hvis du ønsker å utarbeide enda en studie.
Klikk på Nei - hvis du ønsker å avslutte dialogboksen «Ny studie».

Koble USB-kabelen fra enheten.

Klargjøring av en ny studie (WatchPAT™ ONE)
Kontroller at internettforbindelsen er aktiv 
Klikk på Fil>Nye studiedetaljer i zzzPAT eller klikk på «Ny studie»-ikonet [image: ] i verktøylinjen.
Dialogboksen «Ny studie» vises.
Fyll ut de obligatoriske feltene: Pasient-ID, enhets-SN og PIN-kode.
[bookmark: _Hlk527616295]Sørg for at e-postadressen som vises på skjermen er den riktige adressen for mottak av e-postvarsler (e-postadressen defineres under oppsett).
Angi eventuell tilleggsinformasjon, de øvrige feltene er valgfrie.
Velg alternativet «Flere netter» for å kjøre opptil 3 netter med den samme WatchPAT™ ONE-M-enheten ved å bytte sonde hver natt. Dette alternativet vises bare hvis funksjonen er aktivert i Oppsett>Generelle innstillinger>Generelle alternativer. Når «Flere netter» er merket av, vises valget mellom «2 netter» og «3 netter», der standardvalget vil være i henhold til det som er definert i Generelle alternativer. Ytterligere obligatoriske tekstbokser vises opp for å definere de ekstra sondenes SN-nummer
Klikk på «Registrer WP-ONE»-knappen for å registrere enheten og sondene. Registrering vil mislykkes hvis noen av følgende skjer:
· Hvis et av SN-numrene er ugyldig eller mangler. 
· Hvis et av SN-numrene allerede er registrert.
Start studien for WatchPAT™ 300- eller WP200(U)-enheten ved hjelp av «Bytt til WP-enhet»-knappen.

	[image: clip_image002]
	Merk

	
	Hvis samme WatchPAT™ ONE -enhet SN allerede er registrert, vil det vises en feilmelding som varsler brukeren om å sette inn riktig/annen enhets-SN.
Fyll ut riktig informasjon og trykk en gang til på Registrer WP-ONE-knappen.



	
	

	
	Enhetene som brukes for vekt og høyde i dialogboksen «Ny studie» er definert av PC-ens regionsinnstillinger.




Når pasientopplysningene er registrert på webserveren, vises meldingen om at lagringen er utført:

Klikk på Ja - hvis du ønsker å utarbeide enda en studie.
Klikk på Nei - hvis du ønsker å avslutte dialogboksen «Ny studie».

Nye funksjoner på studieskjermen

I tillegg til hovedskjermfeltene som er nødvendige for å klargjøre en ny studie, finnes det andre felt som muliggjør grundig dokumentasjon av pasientens tidligere og nåværende medisinske tilstand. I tillegg lar zzzPAT deg laste inn pasientopplysninger fra tidligere studier. Andre funksjoner på denne skjermen gjør det mulig å organisere studiene i grupper ved å bruke kategoriene du velger.

Se Utvidet og illustrert veiledning for detaljert beskrivelse


[bookmark: _Toc513360269][bookmark: _Toc75938734][bookmark: _Toc396387042][bookmark: _Toc534108055][bookmark: _Toc502848059][bookmark: _Toc125380234]Administrere pasientstudier
WP200 (U)/ WatchPAT™ 300: Når en WP-søvnstudie er fullført, kobler du WatchPAT til USB, åpner zzzPAT-applikasjonen og trykker på Fil>Last inn studie og Analyser fra hovedmenyen. De registrerte digitale dataene lastes inn i zzzPAT-databasen og analyseres automatisk. 
WatchPAT™ ONE: Når en WatchPAT™-søvnstudie er fullført, åpner du zzzPAT-applikasjonen og trykker på Fil>Last inn studie og Analyser fra hovedmenyen. Et vindu åpnes med alle registrerte pasienter hvis studier enda ikke er hentet fra webserveren. Velg studien du vil laste ned, så vil de registrerte dataene bli lastet inn i zzzPAT-databasen for den valgte pasienten. De registrerte dataene analyseres automatisk. Når en studie er godkjent, kan brukeren gjennomgå, redigere, legge til diagnose og anbefalinger og opprette en søvnrapport. Tidligere innlastede studier kan åpnes og gjennomgås.


	
[image: clip_image002]
	Merk

	
	Listen over alle registrerte WatchPAT™ ONE-enheter inkluderer en «Status»-kolonne med følgende alternativer: «Klar», «Ikke startet» og «Pågår». Trykk på «Sjekk status»-knappen for å oppdatere statusen for alle de registrerte enhetene.



	
[image: clip_image002]
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	Det kan søkes etter pasienter ved hjelp av pasient-ID og etter enheter som bruker enhets-SN.




	
[image: clip_image002]
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	Bytt mellom WatchPAT™ ONEs registrerte pasientliste for å laste ned studie fra WP200(U)/ WatchPAT™-enheten med knappen «Bytt til WP200/300».



[bookmark: _Toc534108056]Fil> Nye studiedetaljer

Klargjør pasientfilen på WP for en søvnstudie (avsnitt 4.1).

[bookmark: _Toc534108057]Fil> Last inn studie og analyse

Denne kommandoen laster inn søvnstudiedataene fra enheten og lagrer dem i zzzPAT-databasen.
Mens dataene lastes inn, vises meldingen «Laster inn studie» på skjermen for å indikere at dataene overføres fra WatchPAT til harddisken og pasientfilen lagres i databasen.
[bookmark: _Toc534108058]På dette stadiet utføres automatisk analyse og resultatene blir lagret i databasen. Når den automatiske analysen er fullført, vises resultatene på skjermen. Brukeren kan å vise «søvnrapporten».

WP200 (U)/WP300: Når en flernattstudie er lastet inn, lastes alle nattstudiene automatisk inn og studien som ble lastet inn sist, vises. Bruk dialogboksen Åpen studie for å åpne og gå gjennom alle nattstudiene. 
	
[image: clip_image002]
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	Når du laster inn en studie ved hjelp av WatchPAT™-enheten, kontrolleres fastvareversjonen. Hvis enheten ikke har den nyeste maskinvareversjonen installert, vises følgende varsel:
““En nyere fastvareversjon er tilgjengelig for enhet nr. XXX. Det anbefales at du bruker den nyeste fastvareversjonen.
Bruk 'Hjelp'->'Gå til nettsiden for oppgradering av Watch-PAT-enhet' for å laste ned programvre for oppdatering.”
Se avsnitt 5.8 for ytterligere informasjon om hvordan du oppgraderer fastvareversjonen.



[bookmark: _Ref5870366][bookmark: _Ref449882566]
Fil>Åpne studiefil 

Åpner studier som er lagret i zzzPAT-databasen fra tidligere nedlastede studier. Dobbeltklikk på en pasient, så vises en liste over den pasientens studier med dato og klokkeslett for hver studie. Dobbeltklikk på [image: ] studieikonet for å laste inn og vise registrerte opplysninger på skjermen. 
Hvis flere analyser vises for en studie, vises en dialogboks der du blir bedt om å velge hvilken analyse som skal åpnes.

Velg studier-knappen
Gjør det mulig for brukeren å definere, velge og organisere de viste studiene i dialogboksen «Velg pasientstudie».
Se Utvidet og illustrert veiledning for detaljert beskrivelse
[bookmark: _Toc534108061][bookmark: _Toc534108062]Fil>Lagre studieresultater

Lagrer de aktuelle pasientstudieresultatene (hendelser) som vises uten å lukke zzzPAT og merker studien som gjennomgått. Denne funksjonen er viktig når respiratoriske hendelser redigeres (legges til eller slettes) og de nye hendelsene må lagres for fremtidige zzzPAT-økter.

Fil>Lagre som ny analyse

Lagrer den nåværende analysen med gjeldende hendelser og signaler som en ny analyse. 

Fil>Lukk studie

Lukker den aktuelle pasientstudien som vises uten å lukke zzzPAT.

Fil>Avslutt 

Lukker både pasientstudien som vises og zzzPAT.

[bookmark: _Ref54576982][bookmark: _Toc534108063][bookmark: _Toc513360270][bookmark: _Ref508254354]Rediger> Studiedetaljer

Åpner dialogboksen «Vis studiedetaljer» med informasjon om den aktuelle pasienten. Denne informasjonen kan redigeres ved å trykke på Rediger-knappen. Autoriserte brukere kan endre pasient-ID bare én gang.

Rediger>Angre
Ved å velge «Angre» eller klikke på [image: ] verktøylinjen i zzzPAT kan brukeren angre den siste handlingen. 

Rediger>Rediger søvnstadier med musen
Velger du dette alternativet eller klikker på [image: ] på verktøyslinjen i zzzPAT veksles alternativet som lar deg redigere søvnstadiene og CRS-tidene manuelt med musen. Hvis alternativet er valgt og med musepekeren over en søvnstadiehendelse (f.eks. lett søvn), vil musepekeren gjøres om til en hånd, og den valgte hendelsen kan dras eller endres størrelse på. 

[bookmark: _Toc448932666]Rediger>Kopier …
Når en signalseksjon er uthevet, aktiveres kopifunksjonen slik at brukeren kan kopiere ønskede data enten til utklippstavlen som et bilde eller til en fil i binærformat.
[bookmark: _Toc75938735][bookmark: _Ref519084358][bookmark: _Toc396387043][bookmark: _Toc125380235]Visningsskjermen

Hovedskjermen viser WPs registrering av bølgeformer med hendelsene som ble påvist ved automatisk analyse. Sporingene vises synkronisert til en jevn tidsbase.

[bookmark: _Ref66728932]Se Utvidet og illustrert veiledning for detaljert beskrivelse
[bookmark: _The_All_Night][bookmark: _Ref6238670][bookmark: _Toc534108064][bookmark: _Toc513360271][bookmark: _Ref520722074]Hele-natten-vindu og visningskanaler

Du kan vise den kanalen du elger i visningen «Hele-natten-vindu» selv om du endrer tidsgrunnlaget for visning av alle kanalene i studien.
For å vise til Hele-natten-vinduet navigerer du gjennom Vis>Hele-natten-vindu og merker av alternativet «Hele natten».
Eventuelt Vis>Kanaler.
Merk av boksen til høyre for «Synlig» i Hele natten-delen.
Velg kanalen du vil vise i «Hele natten»-vinduet.

Se Utvidet og illustrert veiledning for detaljert beskrivelse

[bookmark: _Toc513360272][bookmark: _Toc534108065]
[bookmark: _Toc534108067][bookmark: _Toc513360275]Den aktive kanalen

Ved å klikke på en kanal eller en kanaltittel aktiveres kanalen (fargen på det aktiverte signalet og titlene endres).


Et høyreklikk på en kanaltittel aktiverer kanalen og åpner en hurtigmeny 

[bookmark: _Toc513360284][bookmark: _Toc534108068]
Statuslinje

Statuslinjen nederst på skjermen inneholder følgende informasjon:
Databaseforbindelse (delt eller lokal)
Sanntidsklokke
Starttid for uthevet segment
Sluttid for uthevet segment
Varighet
Tidsmodus (REL/ABS)
[bookmark: _Toc75938736][bookmark: _Ref520722093][bookmark: _Toc396387044][bookmark: _Toc534108069][bookmark: _Toc513360276][bookmark: _Toc125380236]Alternativer for signalvisning
[bookmark: _Ref519093479][bookmark: _Toc513360273][bookmark: _Toc534108070]Vis> Definer kanaler i montasje 
Montasjeskjermen består av en liste over alle signalkanaler som er tilgjengelige for visning:
PAT- PAT-signal.
Pulsfrekvens - Avledet fra PAT-signalet.
PAT-amplitude - PAT-signalkonvolutt.
SpO2 - Metningsnivå av arterielt blodoksygen.
Aktigraf - Aktigrafsignal.
WP-stadier – REM, lett søvn, dyp søvn og våken tilstand.
Kroppsposisjon (valgfritt)
Snorking (valgfritt)
Pustebevegelser (valgfritt)

Se Utvidet og illustrert veiledning for detaljert beskrivelse
[bookmark: _Toc23069146][bookmark: _Toc23069145][bookmark: _Toc23069144][bookmark: _Toc23069143][bookmark: _Toc23069142][bookmark: _Toc23069141][bookmark: _Toc23069140][bookmark: _Toc23069139][bookmark: _Toc23069138][bookmark: _Toc23069137][bookmark: _Toc23069136][bookmark: _Toc23069135][bookmark: _Toc23069134][bookmark: _Toc23069133][bookmark: _Toc23069132][bookmark: _Toc23069131][bookmark: _Toc23069130][bookmark: _Toc23069129][bookmark: _Toc23069128][bookmark: _Toc23069127][bookmark: _Toc23069126][bookmark: _Toc23069125][bookmark: _Toc23069124][bookmark: _Toc23069123][bookmark: _Toc23069122][bookmark: _Toc23069121][bookmark: _Toc23069120][bookmark: _Toc23069119][bookmark: _Toc23069118][bookmark: _Toc23069117][bookmark: _Toc23069116][bookmark: _Toc23069115][bookmark: _Toc23069114][bookmark: _Toc23069113][bookmark: _Toc23069112][bookmark: _Toc23069111][bookmark: _Toc23069110][bookmark: _Toc23069109][bookmark: _Toc23069108][bookmark: _Toc23069107][bookmark: _Toc23069106][bookmark: _Toc23069105][bookmark: _Toc23069104][bookmark: _Toc23069103][bookmark: _Toc23069102][bookmark: _Toc23069101][bookmark: _Toc23069100][bookmark: _Toc23069099][bookmark: _Toc23069098][bookmark: _Toc23069097][bookmark: _Toc23069096][bookmark: _Toc23069095][bookmark: _Toc23069094][bookmark: _Toc23069093][bookmark: _Toc23069092][bookmark: _Toc75938737][bookmark: _Toc396387045][bookmark: _Toc534108081][bookmark: _Toc513360285][bookmark: _Ref508258348][bookmark: _Ref508258341][bookmark: _Ref508258251][bookmark: _Ref508258225][bookmark: _Toc502848060][bookmark: _Toc125380237]Gjennomgang, analyse og rapportstudie
[bookmark: _Toc513360286][bookmark: _Toc534108082]Dataanalyse
zzzPAT-programvaren utfører en automatisk analyse av WPs registrerte signaler. Analysen gir en evaluering av respiratoriske hendelser i søvne, oksygenmetning, pulshastighet og statistikk over søvnstadier. Den viser også statistikk over snorking og kroppsposisjon når SBP/RESBP-sensoren brukes.

[bookmark: _Toc534108098][bookmark: _Toc513360298]Generere en analyse
Registrerte studiedata analyseres automatisk når de er lastet inn fra enheten. Du kan også utføre automatisk dataanlyse ved å klikke på Analyser>Last inn studien på nytt og analyser.
Denne funksjonen laster inn de lagrede studiedataene på nytt og utfører den automatiske analysen. Hvis brukeren har endret filen (lagt til / slettet / endret hendelser), vil disse endringene bli slettet og ikke påvirke analysen.
Når den brukes på en fil som tidligere er analysert og lagret med en eldre versjon av zzzPAT, vil denne funksjonen opprette en ny analyse ved hjelp av den nåværende versjonen av zzzPAT-programvaren.

REM-analyse er en del av den automatisk analysen som nevnes ovenfor. 
Under visse forhold kan REM-analysen ikke med sikkerhet fastslå REM-perioder utfra de registrerte signalene. 
Når det skjer, vil displayet bare inneholde søvn- og våkenfaser, og i rapporten skal statistikkdelen for REM og søvnstadier deaktiveres med teksten "Ufullstendig REM-deteksjon".
Hendelsesadministrering

Hendelser merket med automatisk analyse vises i fargede bokser. Plasserer du markøren over en hendelse, åpnes et verktøytips med følgende informasjon:
Hendelsesnavn
Hendelse opprettet av ... (f.eks. automatisk analyse eller bruker)
Starttid
Varighet

Se Utvidet og illustrert veiledning for detaljert beskrivelse
[bookmark: _Adding_events][bookmark: _Ref54689320][bookmark: _Toc534108092][bookmark: _Toc513360296]
[bookmark: _Toc75938738][bookmark: _Toc396387046][bookmark: _Toc125380238]Rapporter
Alle rapporter kan gjennomgås på skjermen og skrives ut. 
Verktøyslinjen i rapportvisningsmodus inneholder følgende elementer:
For å skrive ut en rapport, klikk på Utskrift-knappen.
For å eksportere en rapport til et annet format, f.eks. pdf, rtf, html osv., klikker du på Eksport-knappen.
[bookmark: _Ref530981062][bookmark: _Toc534108093]Brukeren kan vise hvor mange sider en rapport inneholder og velge hvilken side som skal vises ved å bruke [image: rep3]-ikonene.

Se Utvidet og illustrert veiledning for detaljert beskrivelse

0. [bookmark: _Report>Sleep_Report][bookmark: _Ref6288001][bookmark: _Toc534108094][bookmark: _Ref434171410]Rapport>Klinisk diagnose
Dette alternativet lar deg legge til en diagnose og anbefalinger på skjermen for søvnrapport. Informasjonen som er fylt ut i denne skjermen, vises på den første siden av søvnrapporten. 
· Signer rapporten ved å tastet inn navnet ditt eller velge det fra navnemenyen.
· Merk av alternativet ‘Angi som rapportert’ for å vise at den aktuelle studieanalysen er endelig og at søvnrapporten er en endelig rapport for denne analysen.
· Merk av alternativet‘Ingen AHI-sentralstatistikk’ for å utelukke statistikk om sentralapné i rapporten.
· Merk av alternativet ‘Send til HL7’ hvis HL7-tjenesten er installert og aktivert for å sende den spesifikke stutdien til HL7. Merk at avkrysningsboksen må merkes for hver studie som må sendes til HL7.

Rapport> Søvnrapport
Søvnrapporten genererer en én, to, fire eller fem siders rapport som viser et sammendrag av pasientens søvnstudie i henhold til innstillingene 
Rapportens første side inneholder pasientinformasjon, søvnstudieinformasjon, henvisende lege, medisinsk historikk, diagnose og anbefalinger. 

Den andre siden viser studieresultatene, inkludert sammendrag av søvn, PAT-respiratorisk forstyrrelsesindeks (pRDI), PAT apné-hypopnéindeks (pAHI), PAT sentralapné-hypopnéindeks (pAHIc)*, antall hendelser, prosentandel av total søvntid med Cheyne-Stokes-respirasjon (%CSR)*, statistikk over oksygenmetning, inkludert oksygendesatureringsindeks (ODI), gjennomsnittlig, maksimum og minimum oksygenmetningsnivå, oksygenmetningsanalyse, pulsfrekvensstatistikk, REM-søvnanalyse og AHI alvorlighetsgraf.

Den tredje siden viser grafiske visninger av respiratoriske hendelser, snorke- og kroppsposisjonskart (hvis en snorke/kroppsposisjonsensor ble brukt),  oksygenmetning, pulshastighet, PAT -amplitude, våken / lett søvn / dyp søvn og REM -stadier. 

Den fjerde siden viser sektordiagrammer med søvn-/våkentilstander og søvnstadier, søvnforsinkelse, REM-forsinkelse, antall vekkinger og søvneffektivitet og snorking og statistikk over kroppsposisjon (hvis en snorke/kroppsposisjons-sensor ble brukt).

Den femte siden av søvnrapporten (valgfri) er en valgfri side som ikke skrives ut som standard. For å skrive den ut må du først velge alternativet «Oksimetri- og pulsfrekvenshistogramside i søvnrapport» under Generelle innstillinger (se avsnitt 3.3.7). Følgende oksymetri- og pulsfrekvenshistogrammer vises på denne siden
· Oksygenmetningsfordeling: Antall sekunder for hver oksygenmetningsverdi
· Antall desaturasjonshendelser for hvert topppunkt med oksygenmetningsmetning 
· Antall desaturasjonshendelser for hver desaturasjonsdybde
· Antall desaturasjonshendelser for hvert minimumspunkt ved desaturasjonshendelse (nadir)
· Pulsfrekvensfordeling: Antall sekunder for hver pulsverdi

Hvis ingen gyldig hviletid foreligger, er histogrammene tomme.


*pAHIc og %CSR-data gis hvis en RESBP-sensor ble brukt. Presentasjon av pAHIc og %CSR er underlagt godkjenning fra landets myndigheter.


Definisjoner:

Sovetid: Total tid i antall timer da pasienten har sovet. 

PAT pusteforstyrrelsesindeks (pRDI): beregnet antall respiratoriske hendelser delt på mengde gyldig søvntid. Vises som respiratoriske hendelser/time. Indeksen beregnes under gyldig «Hele natten», REM og Ikke-REM søvntid.

PAT apné-hypnopnéindeks (pAHI): beregnet antall apné- og hypopnéhendelser delt på mengde gyldig søvntid. Vises som apné- og hypopné -hendelser/time. Indeksen beregnes under gyldig «Hele natten», REM og Ikke-REM søvntid.

PAT sentral apné-hypopnéindeks (pAHIc): beregnet antall sentrale apné- og hypopnéhendelser delt på mengde gyldig søvntid*. Vises som sentrale apné- og hypopnéhendelser/time.

Prosent av total søvntid med Cheyne-Stokes-respirasjon (%CSR): beregnet prosentandel av CSR-mønster fra gyldig søvntid*.

*gyldig søvntid i pAHIc og %CSR kan være forskjellig fra den gyldige søvntiden som brukes i beregningen av andre indekser, fordi RESBP-sensoren også må være gyldig for denne beregningen.

Oksygendesatureringsindeks (ODI): antall oksygendesatureringshendelser (angitt verdi på 3 % eller 4 % minimum desaturering) delt på mengde gyldig søvntid. Vises som desatureringshendelser/time. Indeksen beregnes under gyldig «Hele natten», REM og Ikke-REM søvntid.

REM % av søvntid: REM-søvnstadier som prosent av total søvntid.

Snorkenivå i dBs: Siden snorking kan være et tegn på søvnapné, viser zzzPAT snorkestatistikk. Terskelen fastsettes i samsvar med DB.  Mengden snorking beregnes som prosentandelen av søvntid over den angitte DB-terskelen.  Snorkingens volumnivå vises grafisk (40 - 70 dB område).

Kroppsposisjon: Fem nivåer av kroppsposisjon vises grafisk (rygg, høyre, venstre, mage og sittende). Fordi apnéhendelsenes hyppighet under søvn avhenger av pasientens posisjon og søvnstadium, viser zzzPAT informasjon om søvnvarigheten pr. posisjon - rygg, mage, venstre, høyre og sittende. Den tilhørende prosentandelen i tid for hver sovestilling vises i en graf. Videre er alle registrerte hendelser som f.eks. pusteforstyrrelsesindeks (pRDI), apné/hyperpnéindeks (pAHI) og desaturasjonsindeks (ODI) også vist i rapporten for hver sovestilling, i tillegg til ikke-rygg-posisjon.

AHI-alvorlighetsgraf:  Indikerer alvorlighetsgraden av obstruktiv søvnapné (OSA). I følge American Academy of Sleep Medicine (AASM) kategoriseres den som mild (5-15 hendelser/time), moderat (15-30 hendelser/time) og alvorlig (> 30 hendelser/time). Grensene for kategorisering av alvorlighetsgrad kan endres, se Oppsett> Generelle innstillinger> Analyse/statistikkparametere.
[bookmark: _Toc396387142]
[bookmark: _Toc534108095]Rapport> Søvnrapport for valgt tidsintervall

Dette alternativet genererer en to siders rapport med en oversikt over pasientens søvnstudie i et valgt tidsområde som velges av brukeren.

Slik genererer du en rapport for en valgt tidsområde:
· Markér ønsket del av bølgeformen i signalvinduet ved å klikke og dra musen.
· Klikk på Rapport>Søvnrapport for valgt tidsområde.

Se Utvidet og illustrert veiledning for detaljert beskrivelse

Rapport>Hendelsesrapport

Denne rapporten viser statistikk over ulike hendelsestyper identifisert av den automatiske analysen i zzzPAT og av brukeren.  En grafisk fremstilling viser en lettlest fremstilling av hendelsesfordelingen, og oppsummeringsdelen viser statistisk informasjon. Når den vises på skjermen, kan brukeren dobbeltklikke på et bestemt hendelsesnavn (på den relevante raden under diagrammet) for å vise en detaljert liste over alle hendelsene av denne typen.
[bookmark: _Ref67056148][bookmark: _Toc534108096]Rapport> Søvnindekser

Denne rapporten viser et sammendrag av studieresultater, inkludert pRDI, pAHI, ODI og søvntid.
Rapport>Pasientoppfølgingsrapport

Denne rapporten gjør det mulig å sammenligne flere studier for samme pasient. En grafisk fremstilling av pRDI, pAHI og ODI for de ulike studiene gjør det mulig å raskt finne en trend på tvers av studiene.
Søvn% over den definerte snorketerskelens dB vil også bli vist. 

Rapport>Rapport for pasient

Denne rapporten er utformet som et brev adressert til pasienten der denne blir informert om søvntestresultatene. Den gir følgende pasientopplysninger:
· Total søvntid
· Apné/hypopnéindeks (AHI)
· Pusteforstyrrelsesindeks (RDI)
· Desaturasjonsindeks (ODI)
· Rask øyebevegelse (REM)
Den sammenligner også disse med de vanlige gjennomsnittsindeksene.


	[bookmark: _Hlk97757100][image: clip_image002]
	Merk

	
	zzzPAT-installasjonen installerer 3 patientletter.ini-filer: én for menn, én for kvinner, og standarden som brukes for øyeblikket. Hvis pasientens kjønn er definert, vil den relevante malen vises når pasientrapporten utarbeides på et språk som har grammatisk kjønn; Hvis pasientens kjønn ikke er definert, vises malen for «mann».




Slik oppretter du rapporten for pasienten:
1. I Rapport-menyen velger du Rapport for pasient.
2. Skriv ut rapporten ved å klikke på utskriftsikonet

[bookmark: _Ref96585667][bookmark: _Hlk97757151]Rapport > Detaljert rapport

[bookmark: _Hlk97757231]Rapportens først side er den samme som den første siden i søvnrapporten. Resten av rapportens sider viser grafiske visninger av respiratoriske hendelser, snorke- og kroppsposisjonskart (hvis en snorke/kroppsposisjonsensor ble brukt), oksygenmetning, pulshastighet, PAT -amplitude, våken / lett søvn / dyp søvn og REM -stadier. Hver side representerer én times søvntid.

[bookmark: _Hlk97757352]Rapport > Sammendragsrapport for flere netter

Denne sammendragsrapporten viser statistikk over flere natts søvn. Den aktiveres bare hvis den åpne studien inneholder WatchPAT™ ONE-flernattsdata (se avsnitt 4.1.2.2 for forberedelse av en WatchPAT™ ONE-studie med alternativet for flere netter valgt). Rapporten inkluderer opptil 3 studier (én studie pr. kolonne), hver med samme WatchPAT™ ONE-enhetsinformasjon og pasientstatistikkopplysninger. En kolonne med snittet av studienes verdier (se nedenfor) er også inkludert
[bookmark: _Toc534108112][bookmark: _Toc513360313][bookmark: _Toc513360297][bookmark: _Toc534108097]Utskrift

Studiesignalene som er registrert av WatchPAT™ og zzzPAT-analysen kan skrives ut på følgende måter:
Enten ved å klikke på utskriftsikonet [image: Print Screen Icon] på verktøyslinjen eller ved å velge Fil>Skriv ut.
Brukeren har en rekke alternativer for utskrift:
Skrive ut hele studien
Skrive ut skjermen
Skrive ut bestemte deler definert etter tidsintervall
Skrive ut bestemte kanaler

[bookmark: _Toc75938739][bookmark: _Toc396387047][bookmark: _Ref6148213][bookmark: _Toc534108109][bookmark: _Toc513360310][bookmark: _Toc125380239]Eksporterte data
Se Utvidet og illustrert veiledning for detaljert beskrivelse
[bookmark: _Toc23069150][bookmark: _Toc75938740][bookmark: _Toc396387056][bookmark: _Ref6912350][bookmark: _Toc125380240]Verktøy
[bookmark: _Ref299442665][bookmark: _Toc396387061][bookmark: _Ref97006805]Se Utvidet og illustrert veiledning for detaljert beskrivelse

[bookmark: _Toc75938741][bookmark: _Toc396387065][bookmark: _Toc125380241]Databaseveiviser
[bookmark: _Hlk101182353]Se Utvidet og illustrert veiledning for detaljert beskrivelse
[bookmark: _Toc23069153][bookmark: _Toc534108125][bookmark: _Toc75938742][bookmark: _Toc396387069][bookmark: _Toc513360315][bookmark: _Toc125380242]Feilsøking
	Installasjon

	Problem
	Mulig årsak
	Løsning

	zzzPAT-installasjonsprogrammet kan ikke kjøres.
	Autokjøringsfunksjonen i Windows er ikke aktivert.
	Åpne Min datamaskin>zzzPAT-CD og dobbeltklikk på «Setup.exe».

	
	Windows-versjonen er ikke kompatibel med zzzPAT.

	Bruk PC med egnet operativsystem.

	
	Maskinvarekonfigurasjon under minstekravet.
	Du må ha minst 128 MB RAM og en Pentium-prosessor for at zzzPAT-installasjonsprogrammet skal kunne kjøres.

	zzzPAT gjenkjenner ikke WatchPAT
(bare WP200)
	
USB-stasjon må defineres på nytt.
	
Velg Oppsett-> «Angi WatchPAT-stasjon».  Sett WatchPAT-enheten inn i USB-stasjonen.
Klikk på OK.
Meldingen «Systemet søker etter WatchPAT-enhet» skal vises.
Til slutt skal det vises en liste som inneholder WP200-stasjonen.
Velg WatchPAT-stasjonen og klikk på OK.


	I Windows XP kan brukeren ikke laste inn en studie eller bruke «Databaseveiviserens» hjelpeprogrammer, selv med riktige brukertillatelser i zzzPAT.
	Brukeren har ikke tillatelse til å overskrive på stasjonene disse applikasjonene ligger på. 
	Kontroller brukerens overskrivingstillatelser etter de, og omdefiner etter behov. 


[bookmark: _Toc30911225][bookmark: _Toc396387171][bookmark: _Toc125380247]Tabell 1 - Feilsøking, installering


	[bookmark: _Toc30911226][bookmark: _Toc534108126]zzzPAT

	Problem
	Mulig årsak
	Løsning

	Analyser>Last inn studie på nytt og analyser-alternativet i zzzPAT-vinduet er deaktivert
	Brukeren har ikke tillatelse til å bruke dette verktøyet.
	zzzPAT-administratoren kan endre brukerens utvidede tillatelser. 

	
	Ikke nok ledig plass på harddisken
	Frigjør tilstrekkelig diskplass til å overskride minimumskravet på 100 MB, og prøv igjen

	Kan ikke Laste inn studie (funksjonen er deaktivert)
	Det er mindre enn 200 MB ledig plass på harddisken
	Frigjør tilstrekkelig diskplass til å overskride minimumskravet på 200MB, og prøv igjen

	zzzPAT starter ikke, eller oppfører seg uforutsigbart
	Noen zzzPAT-filer kan være skadet/overskrevet
	Avinstaller og installer zzzPAT på nytt. 

	Den åpne filen viser ikke REM 
	Filen ble lagret med en eldre versjon av zzzPAT som ikke hadde REM-funksjoner eller REM ikke kunne beregnes på grunn av algoritmebegrensningene.
	Kjør analysen ved å velge Analyser>Last inn studie på nytt og analyser

	Kan ikke generere søvnrapport - Knappen Søvnrapport er nedtonet
	Mindre enn 100 MB ledig diskplass
	Frigjør tilstrekkelig diskplass til å overskride minimumskravet på 100 MB, og prøv igjen

	
	Ingen studier ble lastet inn eller studien er ugyldig
	Åpne ønsket studie. Hvis studien er åpen, kan den ha ugyldige data og derfor ikke kunne brukes

	Brukeren kan ikke logge på zzzPAT
	zzzPAT åpnes ikke hvis en annen økt er åpen under en annen bruker
	Sørg for at ingen annen bruker lot en annen zzzPAT-økt stå åpen på PCen. Start PCen på nytt hvis du ikke kan bekrefte

	
	Brukeren er ikke definert i zzzPAT
	Definer bruker av zzzPAT-administrator

	Sending av rapportt på e-post mislykkes
	Microsoft Outlook ble ikke definert som standard e-postklient.
	Definer Microsoft Outlook (eller Outlook Express) som standard e-postklient

	Endringer i hendelsesnavn vises ikke på skjermen
	Hendelsesnavn lagres med den lagrede analysen. Endringer blir bare synlige etter at analysen er kjørt på nytt
	Kjør analysen ved å velge Analyser>Last inn studie på nytt og analyser

	Feil under utskrift
	Ikke-kompatibel skriverdriver
	En postscript-skriverdriver gir mest pålitelig drift med zzzPAT. Installer en passende postscript-driver for skriveren som brukes, og prøv igjen

	Når du har klikket på Ny studie i zzzPAT vises dialogboksen og zzzPAT frosser
	Utilsiktet tdobbeltklikken på Ny pasient-knappen kan føre til at dialogboksen skjules i bakgrunnen
	Trykk på Alt-Tab for å få dialogboksen tilbake i forgrunnen

	«Aktiver alternativ for flere netter» vises ikke i dialogboksen Ny studie
	WP har S/W-versjon lavere enn 2.2182
	Oppgrader WP S/W til nyeste S/W (ring Itamar Help Desk for oppgradering)

	«Aktiver alternativ for inntrengingssikker testing» vises ikke i dialogboksen Ny studie
	WP har S/W-versjon lavere enn 2.2182
	Oppgrader WP S/W til nyeste S/W (ring Itamar Help Desk for oppgradering)

	Ingen data om snorking og kroppsposisjon vises 
	SBP/RESBP-sensoren ble ikke koblet til WP
	Sørg for å koble SBP til WP.
Sørg for at RESBP bare kobles til WP200U eller WatchPAT™ 300

	
	RESBP-sensor ble koblet til WP200 i stedet for WP200U/ WatchPAT™ 300
	Sørg for at RESBP bare kobles til WP200U eller WatchPAT™ 300

	
	Innebygd SW er ikke kompatibel
	RESBP for WP200U: Sørg for å bruke innebygd SW 3.3228 eller nyere

	Ingen data fra åndedrettsbevegelse vises
	RESBP-sensor ble ikke koblet til WP200U eller WatchPAT™ 300
	Sørg for at RESBP bare kobles til WP200U eller WatchPAT™ 300

	Ugyldig oksimetriavlesning (oksimeterverdier på 127 %)
	Signal utilstrekkelig på grunn av sensorfeil/lesefeil under bevegelse / dårlig pulserende signalstyrke
	Hvis den ugyldige oksimetriavlesningen gjentas selv under hvileforhold, må du skifte ut uPAT-sonden. Hvis den fortsatt er ugyldig, må uPAT-kabelen byttes ut, eller kontakt Itamar Medical kundestøtte.


	Varselsmelding: 
Snorke-/kroppsposisjonsdata vises kanskje riktig i studien.
Se brukerhåndboken for ytterligere informasjon
	Alternativ 1:
Hvis en digital RESBP brukes med en enhet som ikke støtter digital RESBP, f.eks. WatchPAT™ 200U, vil ingen gyldige signaler registreres av sensoren og en varselmelding vises. 


Alternativ 2:
Midlertidig frakobling mellom brystsensoren og WatchPAT™-enheten ble identifisert under studien
	Alternativ 1:
Identifisering av digital kontra analog RESBP-sensor(digital RESBP har ikke hvitfarge)

	Analog RESBP
	Digital RESBP

	[image: Analog RESBP
Logo

Description automatically generated with low confidence]
	[image: A picture containing text

Description automatically generated]


Sørg for at digital RESBP barer brukes medWatchPAT™ 300s.

Alternativ 2:

· Bekreft at brystsensoren er riktig koblet til WatchPAT™-enheten. 
· Bekreft at brystsensorens kabel eller kobling ikke har tegn på fysisk skade.
· Bekreft at Snorke-/Kroppsposisjonsdiagrammet inneholder data.
· Bekreft at Kroppsposisjon ikke inneholder ulike NA-verdier etter de 10 første minuttene.
· Bekreft at Snork-verdiene ikke er høye for mesteparten av studien. 
Om nødvendig, kontakt Itamar Medicals brukerstøtte.


[bookmark: _Toc396387172][bookmark: _Toc125380248]Tabell 2 - Feilsøking, zzzPAT
	zzzPAT med modus for delt tilgang

	Problem
	Mulig årsak
	Løsning

	Brukeren kan ikke logge på zzzPAT
	I modus for delt tilgang kan brukeren være definert i den delte databasen men ikke i den lokale, eller omvendt
	Definer bruker i den andre databasen, eller,
Avslutt zzzPAT og logg på den andre zzzPAT-databasen (enten lokal eller delt)

	Finner ikke den lagrede filen
	Filen er lagret i den andre databasen (enten den lokale eller delte databasen)
	· Kontroller hvilken database zzzPAT er koblet til (databasetilkoblingen vises på zzzPAT-statuslinjen)
· Avslutt zzzPAT
· Start zzzPAT og velg den andre databasen du vil koble til
· Velg Fil>Åpne og søk etter ønsket fil

	Den delte databasen er ikke tilgjengelig
	Nettverket er frakoblet
	· Kontroller at zzzPAT-stasjonen er koblet riktig til nettverket, og at nettverkstjenester er tilgjengelige for den. Kontakt systemadministratoren om nødvendig

	Kan ikke åpne valgt studie
	Studien brukes for øyeblikket av en annen zzzPAT-bruker
	· Vent til den andre brukeren lukker studien, og prøv igjen


[bookmark: _Toc396387173][bookmark: _Toc125380249]Tabell 3 - Feilsøking, zzzPAT med modus for delt tilgang


	Verktøy

	Problem
	Mulig årsak
	Løsning

	Forberedelsene til en ny studie mislyktes
	Enheten ble koblet fra USB-en for tidlig.
	Ikke fjern enheten før dialogboksen for det vises at studien er lagret

	Kun WP200(U): Ny studie eller zzzPAT gjenkjenner ikke WP200(U)
	Volumnavnet er slettet
	Formater stasjonen med volumnavn «WP200» 

	Kun WatchPAT™ 300: Ny studie eller zzzPAT gjenkjenner ikke WatchPAT™ 300
	FTDI-driverne ble ikke riktig installert
	Sørg for at FT4222H-grensesnittene A, B, C og D vises i delen «Universell seriebuss-kontrollere» i Enhetsadministrasjon når en WatchPAT™ 300 er koblet til USB. Hvis disse grensesnittene ikke vises, må du kontakte Itamar Medicals kundestøtte

	Databaseverktøy-knappen i «Databaseveiviserens» vindu eller Verktøy i zzzPAT er deaktivert
	Brukeren har ikke tillatelse til å bruke dette verktøyet
	zzzPAT-administratoren kan endre brukerens utvidede tillatelser

	Brukeradministrasjon -knappen i «Databaseveiviserens» vindu eller Verktøy>Brukeradministrasjon er deaktivert
	Brukeren har ikke tillatelse til å bruke dette verktøyet
	zzzPAT-administratoren kan endre brukerens utvidede tillatelser 

	Databaseverktøy åpnes ikke
	zzzPAT eller Ny studie kjører
	Lukk zzzPAT eller Ny studie og åpne databaseverktøy

	Superbruker glemte passordet
	-
	Ta kontakt med en representant for Itamar Medical


[bookmark: _Toc30911227][bookmark: _Toc396387174][bookmark: _Ref30908983][bookmark: _Toc125380250]Tabell 4 - Feilsøking, Hjelpemidler
[bookmark: _Toc75938743][bookmark: _Toc396387070][bookmark: _Toc125380243]Vedlegg A: LISENSAVTALE 

[bookmark: _Hlk527451659]Denne lisensavtalen utgjør den fullstendige og utelukkende forståelsen mellom deg og Itamar Medical. Dokumentet kan vises på 
https://www.itamar-medical.com/lmages/licensewp.pdf


Hvis du har spørsmål om denne lisensavtalen, eller hvis du av en eller annen grunn ønsker å kontakte Itamar Medical, kan du skrive til: 

USA:
Itamar Medical Inc.
3290 Cumberland Club Drive, Suite 100
Atlanta, Georgia 30339, USA
Tlf: 1 888 748 2627

Verden:
Itamar Medical Ltd. 
9 Halamish Street, PO 3579
Caesarea 3088900, Israel
Tlf:  +972 4 617 7000








[bookmark: _Toc75938744][bookmark: _Toc396387073][bookmark: _Toc261876528][bookmark: _Toc125380244]Vedlegg B:  Tilsynsrepresentant
Itamar Medicals autoriserte tilsynsrepresentant:

[image: cid:image008.jpg@01C99FE5.E9650A10]Arazy Group GmbH 

The Squaire 12, Am Flughafen,
60549 Frankfurt am Main, Germany

[bookmark: _Toc75938745][bookmark: _Ref244235447][bookmark: _Ref244235456][bookmark: _Ref244235572][bookmark: _Toc125380245]
Vedlegg C: Aktiverer NAF-kanal (termisk luftstrømsensor).
zzzPAT støtter presentasjon av NAF-signal (Nasal Air Flow) i kanalvisningen mens NAF-tilbehør brukes under studien.

Aktivering av NAF-kanal
1. Åpne/last inn en studie som ble registrert med NAF-tilbehør tilkoblet
2. Under Vis, Definer kanaler i montasje
[image: ]
3. NAF- og NAF-filtrerte (NAF-kanal med filter som reduserer støyen på signalet) kanaler vil vises på venstre liste (Alle kanaler)
Merk NAF-kanalen og klikk Legg til, og klikk deretter OK

[image: Graphical user interface, application, Word

Description automatically generated]
4. Gå til Oppsett, Brukerinnstillinger, Administrer Montering-fanen. Klikk Lagre som og gi navn til den nye montasjen med NAF-kanalen lagt til 
[image: ]
5. Etter Lagre vil den nye Montasjen bli lagt til montasjelisten.
6. Klikk på Angi som standard og klikk på OK
[image: ]


[bookmark: _Toc75938746][bookmark: _Toc396387074][bookmark: _Toc125380246] Vedlegg D: Indeks

A
Analyze>Reload study and analyze · 17
D
Database Tools · 31
Database Wizard · 10, 25, 26, 31
E
Edit>Copy · 15, 16
Event
Management · 17
Export
Export a report · 18
F
File>Close Study · 15
File>Exit · 15
File>Load Study and Analyze · 14
File>New Study Details · 10, 11, 13
File>Open Study · 15
File>Print · 22
O
ODI · 18, 20, 21
P
pAHI · 18, 19, 21
pRDI · 18, 19, 21
pREM · 20
Printing · 22
Print a report · 18
R
Report · 18
Event Report · 20
Patient Follow-up Report · 21
S
Setup>Directories · 9
Setup>Settings · 9
Status Bar · 16
U
User Administration · 31
V
View>All Night Window · 16
View>Channels · 16
View>Study Details · 15
Z
zzzPAT
Using · 10
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